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PhotoDisc® 

The image you need when you need it. You know how the right image can make your design or concept come 
to life. With PhotoDisc images at your fingertips, you now have access to tens of thousands of intriguing, easy-
to-use, royalty-free images to inspire your best ideas. Our collection is rigorously edited for aesthetic value, 
affordably priced, and backed by technical expertise and the best customer service team in the industry.

Technically superior images that save you time. Because each of our digital images is meticulously scanned on 
state-of-the-art equipment and color corrected, you're assured of seeing the high-quality image you expect, 
whether your medium is print or online, every time.

Exceptional service you can count on. Not only does PhotoDisc have the images you need, but you can rely on 
the expertise and enthusiasm of a dedicated customer service team. We make sure you get the image you need
when you need it. Call us at one of the numbers below for assistance. You'll be amazed at what you can find at 
PhotoDisc. 

www.photodisc.com

Our website never sleeps. We're open 24 hours a day, 7 days a week, for you to search, purchase and 
download images from our secure website. Download free 150K comping images, or purchase 600K, 10MB or 
28MB images (designed for full-page printing (8.5 x 11 and A4) at 300dpi, or larger at lower resolution).

Systems Recommendations
To take full advantage of the Image Search and Clip Search catalogs, we recommend the following as minimum 
system requirements. However, digital imagery from both our comping discs and product discs can be opened in
a variety of editing tools available for almost any system.

Still Image Products
Macintosh®: Power Macintosh®, Apple® system software version 7.6.1 or later, QuickTime® 3.0, 32MB of 
RAM, 50MB of available hard drive space, color monitor and CD-ROM drive.

PC: Pentium processor, Microsoft® Windows® 95 (or Windows NT® 3.5 or later), QuickTime 3.0, 32MB of 
RAM, 50MB of available hard drive space, color monitor and CD-ROM drive.

The Film Series
Macintosh: Power Macintosh G3, Mac® OS 8.0 or greater, 64MB RAM, 1GB available hard drive space, 
QuickTime 4.0, 8x CD-ROM drive or faster, video accelerator card, video digitizing board capable of reading and
utilizing various compression formats including PhotoJPEG, 24-bit color monitor

PC: Pentium processor or greater, Windows 95 with 48MB RAM, or Windows NT 3.51 or later with 64MB RAM, 
1GB available hard drive space, 4x CD-ROM drive, QuickTime software, 24-bit color video display card, video 
digitizing board capable of reading and utilizing various compression formats including PhotoJPEG, 24-bit color 
monitor



What Can I Do with My Image Finder™ CD?

The Image Finder CD is your resource for searching the entire PhotoDisc CD-ROM collection. Using the Master 
Keywords list, you can keyword search the Image Finder CD for thumbnails of any images in our current CD-
ROM collection. Once you find the image(s) you like you can get the comp(s) either from your Resource Book 
comping disc or online at www.photodisc.com. You can buy the PhotoDisc CD-ROM(s) with your image(s) 
from your local PhotoDisc office or you can go to www.photodisc.com to purchase and download still image(s)
or purchase CDs.

Contents
1.  Image Search catalog for searching your Image Finder CD
2.  Extensis® Portfolio™ 4.0
3.  PhotoDisc Toolkit
4.  READ ME file

What Can I Do with the Comping Disc That Came with My Book?

You can keyword search for any image in the associated book and access the150K comps for that image. You 
can use the 150K comp in your initial layouts.

Contents
1.  Image Search catalog for searching your CD
2.  Photos folder containing 150K comping images
3.  Extensis Portfolio 4.0
4. The comping discs included with certain books may contain sample high-resolution images

What Can I Do with My Product Disc?

Each PhotoDisc product CD contains low- and high-resolution images for your onscreen and print design needs.
You can use these in final projects, subject to the license agreement included with each disc. 

Contents
1.  Image Search catalog for searching your CD
2.  Photos folder containing JPEG compressed RGB images
       600K (5" x 7" at 72dpi)
       10MB (5" x 7" at 300dpi)
       28MB files (8.5" x 11" at 300dpi)*
3.  Extensis Portfolio 4.0
4.  READ ME file

*28MB files available for select CD products.

Using the Images
PhotoDisc images are saved as JPEG image files using minimum compression for maximum quality. Some 
applications may not correctly separate JPEG images for printing. If this is the case with your application, 
convert your images to TIFF or EPS file format prior to placement within the application. Save your files as TIFF
or EPS after image-editing work, as repeated compression can degrade image quality. If it is necessary to save 
storage space, use JPEG compression at the end of your workflow.

Our images are saved in RGB because they are meant to be as versatile as possible for the end user. When an 
RGB image is converted to CMYK, several parameters must be taken into consideration, including paper stock, 
4-color film output device, layout software programs used, types of inks used and special effects intended by 
you, the designer. We don't want to make these decisions for you. We would rather you have the control in 
deciding exactly how your images are converted to CMYK. To learn more about color management, go to 
www.photodisc.com and click 'Designer Resources' on our homepage. Then under 'Toolbox', click 'Managing 
Your Color'.



What Can I Do with My Film Series Disc?

Each Film Series CD-ROM (or CD-ROM set) contains the highest-quality 16mm and 35mm original 
cinematography clips. Each scene has been carefully transferred from film to D1 tape, then from D1 tape to 24-
bit digital QuickTime movies in all of the resolutions listed below. The minimum necessary PhotoJPEG 
compression has been used in the digital video capture to optimize file size, while retaining the best image and 
playback quality possible, and still resulting in less than 3% compression. All QuickTime files are flattened, 
enabling reliable cross-platform playback with any applications that recognize the QuickTime format.

Contents
1.  Image Search catalog for searching your CD
2.  Clips folder containing PhotoJPEG compressed QuickTime movies
       Full-Screen: standard broadcast resolution D1 NTSC (720 x 486 pixels at 30 fps)
       Multimedia: standard multimedia resolution (320 x 240 pixels at 15 fps)
       Internet/Preview: standard web resolution (160 x 120 pixels at 15 fps)
3.  Extensis Portfolio 4.0
4.  QuickTime Installer
5.  READ ME file

Finding the Clip You Need
The clips are organized in the named folders by clip number. You can find the clip number listed under each clip 
in the printed catalog or in the electronic catalog. Open the electronic catalog in the Catalog folder to preview 
and compare all of the clips on this disc. 

Using the clips
Full-Screen resolution: Full screen clips are provided in D1 NTSC resolution, with a frame size of 720 x 486 
pixels at 30 fps. This is the largest file provided in this series and is suitable for high-end production applications,
including broadcast television.

Multimedia resolution: Multimedia clips are provided for general computer-based multimedia applications, 
including games and CD-ROM publishing, and are provided in a frame size of 320 x 240 pixels at 15 fps. 

Internet/Preview resolution: The preview files are for reviewing a clip prior to purchase and are provided in the
compact frame size of 160 x 120 pixels at 15 fps. The preview files supplied on Film Series products will not be 
watermarked.

All of these cross-platform files are usable in internet and web applications as well as for playback or other uses 
with Macintosh or Windows applications. For information about using Film Series clips in specific applications 
such as Adobe® Premiere®, Adobe After Effects®, Avid® Media Composer® and others, please consult the 
application manual for information on the use of QuickTime files within that application.

Features and Tips

How to Search Through Our CD-ROM Products
In order to get the most comprehensive search results, please use the Image Finder™ CD. If you don't have the
Image Finder CD, please order your free copy from your local PhotoDisc office.

The Portfolio browser on your CD can function for both basic searches and more refined searches. To focus 
your keyword search, use the Boolean feature. Adding 'and', 'not' or 'or' can cut search results down to a more 
manageable size.

Searching by Master Keywords:
Master Keywords can be found in the floating dialog box on the Macintosh and on the left side of the Image 
Finder catalog on the PC.



The Master Keywords are a cumulative list of all the keywords related to every image in a catalog. For example: 
if you enter the word 'dog' in the entry field and click 'Find', it will automatically find all the images that have 'dog' 
in the keywords.

Searching using the Find field:
To bring up the Find entry field, please do the following:
1.  Click 'Catalog' at the top of the screen.
2.  Click 'Find'. This will bring up the Find entry field for keyword searching.

Features of the Find function:
Using the Find field, you can perform individual image number searches, Boolean searches and product 
searches. To search by image number you can enter the number in the Keyword field followed by .JPG. You 
can enter multiple image numbers by selecting 'More Choices', which will allow you to enter several image 
numbers. Boolean operations can also be performed in the Find field. You can search by product by entering the
product code in the Keyword field. For example, if you want to search for the Signature Series 8 disc, enter 
'SS08', and all 100 images from the CD will appear in the browser.

Printing a Gallery of Thumbnails
Using the Portfolio browser you can copy images to a custom gallery for printing or searching. To copy images 
to a gallery, do the following:
1.  Click 'Window' in the menu items at the top of the screen.
2.  Click 'New Gallery'.
3.  You can drag and drop thumbnails from the main Image Finder Gallery to the New Gallery for printing.
4. If you have multiple images to move to the New Gallery: On the Macintosh hold down the Command key 

and click the thumbnails you want to move; then drag and drop them into your new gallery. On the PC hold 
down the Control key and click the thumbnails you want to move; then drag and drop them into your new 
gallery.

5.  To print your gallery, click 'File' and then 'Print'.

Online Features
Click a thumbnail image and see keyword links to similar images.

Preview all the images on any disc before you buy. Once you're in the CD Store simply choose the series and 
disc you’re interested in and click 'Download PDF Catalog'.

Lightbox catalogs let you collect your images and review your selections with others. Take your favorite images 
from your search and place them in an online Lightbox album at our website. Then you, your clients and 
colleagues can view and modify your image selection together before you make your final image choices. Or call
our research consultants and they'll put a Lightbox album together for you, free of charge.

Product Codes
AS - Animation Series
BS - Background Series
DT - Designer Tools Series
FA - Fine Art Series
FS - Film Series
OS - Object Series
SS - Signature Series
V - PhotoDisc Volumes

About Alpha Channels
Alpha channels are used as masks to create knockouts or levels of transparency in an image. Using an alpha 
channel, complex shapes can be “cut out” from the original image. If your disc includes alpha channels, you can 
create effects like transparency (e.g., a glass of water), make objects appear translucent, or allow an image to 
blend more naturally into its background (e.g., hair or fur) without appearing edgy and coarse. For best results, 
alpha channels should be used when compositing multiple image files. Unlike clipping paths, alpha channels will 
not scale to the output resolution of the intended output device. Therefore, they will not provide as smooth an 



edge as the clipping path. In most cases, page layout applications will not recognize the alpha channel and will 
not drop backgrounds out of an image area.

Directions for Utilizing Alpha Channels with Your Object Series Images:
1. In Adobe® Photoshop® 4.0 or later, open both the image file and the corresponding alpha channel file. (E.g., 

OS48001.JPG and OS48001alpha.JPG.)
2. Click on the alpha channel image, then select ‘Show Channels’ from the Window pull-down menu.
3. Drag and drop the ‘Black’ channel from the ‘Channels’ palette onto the RGB image file.
4. To view the image file, reactivate the composite RGB channel. 
5. Command-click (Macintosh) or Control-click (Windows) on the ‘Alpha 1’ channel. You can now use this 

selection to move, copy or manipulate the object without the background.

About Clipping Paths
A clipping path is an outline around an object that allows you to mask the object and separate it from its 
background. This special feature is useful for dropping images onto white space or onto a background image. All
Object Series images have a custom path embedded into all file sizes and can be accessed by opening the 
image in Adobe® Photoshop®. A clipping path will render the smoothest possible edge around your object, 
constrained only by the resolution of your output device. For example, a masked object sent to a 3600dpi 
imagesetter will have a more cleanly defined edge than it would printed on a 600dpi laser printer. Within the 
Clipping Path dialog box, we have left the flatness setting blank for each object. The flatness option allows you 
to specify how smooth the outline will be rendered when being processed for output. The lower the value, the 
smoother the edge of the outlined image. A flatness setting of zero instructs the output device to render the 
smoothest path possible. However, in complex documents a zero setting may cause PostScript® errors on your 
output device. If the setting is left blank, the output device will default to the smoothest possible setting for that 
device. Typically, a flatness setting of 3 to 5 is adequate. Most images can be set to a flatness of 5 to 8 without 
visible degradation of edge quality. You may also use the supplied path to create drop shadows and glow effects
behind your image. These techniques are explained in depth in many third-party Photoshop books. We hope the
supplied paths will save you many hours of tedious work and increase your creative options when using 
PhotoDisc objects.

Directions for utilizing Clipping Paths with your Object Series images:
1.  In the Paths palette in Adobe Photoshop, click 'Outline'. The path will appear superimposed on the opened 
image.
2.  Use the triangle pull-down menu to select the Clipping Path... option.
3.  Select 'Outline' in the Clipping Path dialog box. Click 'OK'. Your clipping path has now been activated.
4.  Save the image as an Encapsulated PostScript® (EPS) file. When the EPS file with the clipping path is 
placed into page layout applications like QuarkXPress™, the masked background will not display or print.

Background Series Seamless Tile Information
With the Background Series, we have included tiles and seamless backgrounds. Seamless backgrounds are 
designed for online and web development or any other multimedia applications. 

On Background Series discs you can find some samples of seamless backgrounds that we created as well as 
the tiles from which they were made. This is a totally subjective process, so if you don't like ours, you can make 
your own.

Below you will find 10 simple steps using Photoshop that will allow you to create your own masterpiece. There 
are other digital imaging software tools such as Kai's Power Tools® that do the same types of things, but they 
are not described here.

Specifications:
Each tile is a selection 100 x 100 pixels in dimension.
Screen resolution (72ppi) TIFF files.
File size is 30K.

Each seamless background is 640 x 480 pixels in dimension.
Screen resolution (72ppi) TIFF files.
File size is 600K.



To create a seamless background in Photoshop 4.0x:
1.  Select a 600K image.
2.  Crop an area of the image you wish to tile. Make this area approximately 100 x 100 pixels.
3.  Under the Filter menu, go to 'Other' and select 'Offset'.
4.  Type in number of pixels you wish to offset (we use a value of 25) and select 'Wrap Around' for undefined 
areas.
5.  Use the Cloning tool ('Rubber Stamp') to smooth out offset seams. This step creates the "seamless" effect.
6.  Save file as a TIFF.
7.  Select 'All' (command+A) and then 'Define Pattern' under the Edit menu.
8.  Create a new document to the size you desire. We used a 640 x 480 pixel dimension at 72ppi.
9.  Under Edit menu, select 'Fill'.

Contents Use: Pattern
Blending Opacity: 100%
Mode: Normal

10. Save file as desired or as GIF for online/web development.

Decompressing and Saving Images
PhotoDisc compresses all its images using JPEG compression. We compress images on the highest setting, 
which ensures the highest-quality image.

Most desktop publishing applications such as Photoshop, support the JPEG file format; however, in case you 
don't have an application that supports JPEG we have provided an application to decompress and save your 
image in a TIFF format.

Note: Your Image Finder CD is only for searching; there are no comp images to decompress or save. These 
directions are for comping discs or PhotoDisc product CDs.

Macintosh Picture Decompress™:
1.  Insert the PhotoDisc CD into your CD-ROM drive and double-click the PhotoDisc icon appearing on your 
desktop.
2.  Double-click the Resource folder that appears in the first window.
3.  Drag the Picture Decompress icon to your desktop and click 'OK'.
4.  Double-click the Picture Decompress icon on your desktop. This will launch the application.
5.  Click 'Desktop', double-click the PhotoDisc icon and then double-click the Photos folder.
6.  Within the Photos folder, open a product folder and double-click a file to open.
7.  From the File menu bar select 'Save As'. Change the file format to TIFF and save the image to a folder on 
your hard drive.
8.  Quit 'Picture Decompress', open your graphic design or page layout application, locate the desired image 
from your hard drive and import the image into your application.

Note: Picture Decompress requires 15 - 40MB of allocated RAM to open the 28MB images. If you don't have the
required RAM, activate 'Virtual Memory' in your Memory control panel. Please reference your Macintosh Users 
Guide if you need assistance.

PC:
1.  Insert the PhotoDisc CD into your CD-ROM drive.
2.  Go to File Manager (Windows NT) or My Computer (Windows 95), and access your CD-ROM drive, usually 
your D: drive.
3.  Double-click the CD-ROM drive.
4.  Double-click the Decompress folder found in 'Software' inside 'Resources'
5.  Double-click 'Viewer.exe.' found in the Browser folder. The Viewer application will launch.
6.  Locate your CD-ROM drive and click the CD icon.
7.  Click the Photos folder. In the Photos folder double-click the image you want to decompress. This will launch 
the Ulead Viewer application and preview your image.
8.  To convert the image from JPEG to TIFF, click 'File' at the top of the screen. 
9.  Click 'Save As'. In the Save As dialog box, in the List Files of Type drop-down menu, select 'TIFF' and then 
click 'OK' (make sure you write down where you save your file on your hard drive).



Licensing Made Easy

We've streamlined our licensing plan so that it's easier than ever to use royalty-free digital stock photography. 
Our three categories of licensing include an Image Finder™ license, a Comping license and a Royalty-Free 
license.

Image Finder License
The Image Finder license applies to all the images and clips on your Image Finder disc and only allows you to 
search through, view and reference the images and clips on this disc. The images and clips on this disc cannot 
be used for comps or projects.

Comping License 
The Comping license applies to all images on your comping disc and any images that you download free from 
the PhotoDisc website. Use these images in your initial layouts and to create comps to show your clients and 
colleagues.

Royalty-Free License 
The Royalty-Free license applies to any digital imagery over 150K that you purchase from PhotoDisc. You may 
use this digital imagery in any project, including any advertising, promotion or editorial project, either 
electronically (such as in web design) or in print, and any broadcast or theatrical exhibition, as well as for any 
packaging (including music, video and software), any book (including jacket and interior pages), and any item for
sale, regardless of quantity produced. Pornographic, defamatory, libelous or otherwise unlawful use of any 
digital imagery, of course, is prohibited.

Your Royalty-Free also includes an automatic 10-user license. If you would like to share an image with more 
than 10 people (including you), please contact PhotoDisc, by email at license@photodisc.com, or by phone at 1 
800 528 3472 (US and Canada) or +1 206 441 9355 (international).

Please see the printed license agreement that comes with each product for full details on our licensing plan. For 
further license information, call your local PhotoDisc office. See "Contacting PhotoDisc" for telephone numbers.

Contacting PhotoDisc

In the US and Australia we take orders, search for images for you and answer your questions free of charge, 24 
hours a day, 7 days a week.

Worldwide Customer Sales and Service
US/Canada
PhotoDisc, Inc.
701 North 34th Street
Suite 400
Seattle, Washington 98103
USA

Toll Free: 1 800 528 3472
Toll Free (en français): 1 800 883 1404
Email: sales@photodisc.com
Technical Support: 1 206 269 1695
Email: webtech@photodisc.com
Fax: 1 206 441 4961

Europe/Middle East/Africa
PhotoDisc Europe Ltd.
101 Bayham Street
London NW1 0AG
United Kingdom



Customer Service: +44 (0)20 7428 6103
Email: sales@photodisc.co.uk
Technical Support: +44 (0)20 7428 6104
Email: pdetechsupport@photodisc.co.uk
Fax: +44 (0)20 7428 6129

International
Customer Service: +1 206 441 9355
Email: sales@photodisc.com
Technical Support: +1 206 269 1695
Email: webtech@photodisc.com
Fax: +1 206 441 4961

Australia
PhotoDisc Australia Pty Ltd
38 Atchison Street
St Leonards NSW 2065
Australia

FreeCall: 1800 240 611
Tel.: 02 9439 0456
Email: ozinfo@photodisc.com
Fax: 02 9439 0476

Benelux
PhotoDisc Benelux
Le Mairekade 77
1013 CB Amsterdam
The Netherlands

Tel.: +31 (0)20 5 849 649
Email: sales@photodisc.nl
Fax: +31 (0)20 5 849 620

Brazil
PhotoDisc do Brasil Ltda.
Av. 9 de julho, 4865
conjunto A-102, 10° andar
CEP 01407-200
São Paulo
Brasil

Tel.: (11) 3061 3397
Tel.: (11) 3064 7731
E-mail: info_photo@photodisc.com.br
Fax: (11) 3068 0281

Denmark
PhotoDisc Denmark
Østerbrogade 114, 1
2100 København Ø
Denmark

Tel.: +45 35 25 33 30
Email: kundeservice@photodisc.dk
Fax: +45 35 25 33 35



Finland
PhotoDisc Finland
Lönnrotinkatu 22 A4
00120 Helsinki
Finland

Tel.: +358 (0)9 5657 270
Email: asiakaspalvelu@getty-images.com
Fax: +358 (0)9 5657 2799

France
PhotoDisc
4, Bd. Poissonnière
75009 Paris
France

Service clients : 01 55 77 00 57
Email : service@photodisc.fr
Télécopie : 01 55 77 00 56

Germany/Austria/Switzerland
PhotoDisc Deutschland
Bahrenfelder Chaussee 49
D-22761 Hamburg
Deutschland

Gebührenfreie Service-Line für Deutschland, Österreich, Schweiz
Tel.: 00800/20 00 30 30
e-Mail: service@photodisc.de
Fax: 00800/20 00 30 31 

Hong Kong
PhotoDisc Hong Kong
1/F Tien Chu Commercial Building
173-174 Gloucester Road
Wanchai
Hong Kong

Tel.: (852)-2574 7788 
Email: getinfo@getty-images.com.hk
Fax: (852)-2574 8884

Italy
PhotoDisc Italia
Via Carroccio 10
20123 Milano MI
Italia

Numero Verde: 8000.75425
Tel.: +39 02.833.831
Email: Tech@photodisc.it
Fax: +39 02.8338.3838

Japan
PhotoDisc Japan K.K.
Nishi-Shibuya Highway Building 5F
2-23-1 Ohashi, Meguro-ku
Tokyo 153-0044



Japan

Free Dial: 0120 369 299 
Fax: 03 3468 4106

New Zealand
PhotoDisc New Zealand
P.O. Box 47-396
Ponsonby
Auckland
New Zealand

Free Call: 0800 462 431
Tel.: 09 361 2552
Email: pda_tech_support@photodisc.com
Fax: 09 361 2553

Portugal
PhotoDisc
4, Bd. Poissonnière
75009 Paris
France

Tel.: 01 55 77 00 57
E-mail: service@photodisc.fr
Fax: 01 55 77 00 56

Scandinavia
PhotoDisc Scandinavia AB
Storgatan 46
114 55 Stockholm
Sweden

Customer Service: +46 8 545 85 151
Free Phone (Sweden): 020-53 52 51
Email: kundservice@photodisc.se
Technical Support: tech@photodisc.se
Fax: +46 8 545 85 155

Spain
PhotoDisc Spain
Aribau, 200-210 3º
08036 Barcelona
Spain

Llamada gratuita: 900 314 209
Tel.: 933 620 460
E-mail: info.spain@photodisc.com
Fax: 933 620 461

United Kingdom
PhotoDisc UK
101 Bayham Street
London NW1 0AG
United Kingdom

Customer Service: 020 7428 6103
Lo-call: 0845 302 1212



Email: sales@photodisc.co.uk
Technical Support: 020 7428 6104
Email: pdetechsupport@photodisc.co.uk
Fax: 020 7428 6129

PhotoDisc and the PhotoDisc logo are official trademarks of PhotoDisc, Inc. and are registered in some 
countries.
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